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1. Introduction 
This document is the user manual for TeliViewer. It is the tool for setup, image acquisition, and display for 

the camera products of Toshiba Teli, such as USB3/GigE/CoaXPress. 

TeliViewer is available when TeliCamSDK is installed into your system since it is provided with TeliCamSDK 

package.  

 

1.1. Terms  

Following table explains the terms that are used in this document. 

 

Term Description 

Main window 
It is a centrally located window that displays images from the camera. Such a 

window is called as “Main window”. 

Pane 
It is a small window implemented for camera controls such as Discovery, 

FeatureView, etc. Such a window is called as “Pane”. 

Stream 

Streaming 

Image data form camera is called as “Stream”, and operation to acquire the 

image is called as “Streaming”. 

Capture Rate It is the frame rate (FPS) of currently acquiring the image from camera. 

Display Rate It is the frame rate (FPS) of currently displaying the image on Main window. 

GEV GigE Vision. It is a protocol supported by GigE cameras. 

U3V USB3 Vision. It is a protocol supported by USB3 cameras. 

Plug-in 

Plug-out 

The operation of connecting a camera to a system is called as “Plug-in”, and 

the operation of removing a camera from the system is called as “Plug-out”. 

Context menu 

This menu is displayed by right-clicking with the mouse on the window or 

pane. This allows users quick operations. Its usage will be explained in 

following sentences for each feature if it is available. 

2in1 mode 

4in1 mode 

The “2in1” mode divides the main window into two windows, allowing two 

camera images to be displayed, and the “4in1” mode divides the main window 

into four windows, allowing four camera images to be displayed at the same 

time. 

Current Area 

In “2in1” or “4in1” mode, the main window is divided into multiple areas. When 

a divided area is selected by clicking on it with the mouse, the selected area is 

encircled by red frame, and targeted for operation, called as “Current Area”. 

RW / RO / WO 
They indicate the item's attributes as following. 

RW: ReadWrite, RO: Read-Only, WO: Write-Only 

 It explains regarding the recommended usage for users, or the supplemental 

remarks for reference. 

 It explains regarding the issue that user should pay attention for using 

TeliViewer. 

 

Hint 

Attention 
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2.  System Configuration 
TeliViewer works with TeliCamApi that is provided by TeliCamSDK. If users need detailed information on 

system configuration, etc., refer to the "TeliCamSDK Start-Up Guide" or "TeliCamSDK for Linux Start-Up 

Guide". 

 

3. Operation Environment 
The basic requirements for the working environment are same as for the TeliCamSDK. For more details, refer 

to the "Hardware Requirements" and "Software Requirements" in the "TeliCamSDK Start-Up Guide" or 

"TeliCamSDK for Linux Start-Up Guide". 

This section describes the TeliViewer specific requirements. 

 

3.1. Regarding Streaming of Multiple Cameras 

The “Multi-Display” feature described in the following section can stream multiple cameras at the same time. 

This is a useful feature since it allows users to view images from multiple cameras on a single screen at the 

same time, but it requires high hardware performance. 

The recommended specifications for streaming multiple cameras simultaneously are following. 

 

Recommended PC Specs ・CPU  : Intel Core i series 6th generation or later, 4 threads or more 

・Memory : 8Gbyte or more 

・Graphics : 2Gbyte or more VRAM with OpenGL support 

 

 

Regarding the use of single board 

computers such as Raspberry Pi 

Note that it is difficult to stream multiple cameras simultaneously on systems 

with low hardware specifications, such as the Raspberry Pi. Errors such as 

packet loss or else may occur and the expected performance may not be 

achieved. 

Regarding the use of laptop PCs 

Even if your system meets the above recommended specifications, on the 

laptop PC, there is a case streaming cannot be continued correctly. This 

depends on bandwidth of the data bus on the system, and if such bandwidth is 

insufficient, there is the possibility errors occur, such as packet loss. For this 

reason, it is recommended to use the desktop PC with sufficient bandwidth for 

data bus. 

 

Attention 
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4. Installation 
TeliViewer is installed with TeliCamSDK package. If it is required to know the detailed procedure to install 

the TeliCamSDK package, refer to “TeliCamSDK Start-up Guide” or “TeliCamSDK for Linux Start-up Guide”. 

 

5. Launch of TeliViewer 
To launch TeliViewer, refer to the following procedures. 

 

5.1. Windows 

The procedures for Windows 10 are follows. 

5.1.1. Launch from Start menu 

 

 

 

 

 

5.1.2. Launch from Search result 

 

 

 

 

 

 

5.2. Linux 

The procedures for ubuntu are follows. 

5.2.1. Launch from Search result 

 

 

 

 

 

5.2.2. Launch from filer or terminal 

 

 

 

 

[Procedure] 

1) Press the Start button of Windows. 

2) Open TOSHIBA TELI. 

3) Select TeliViewer and launch it. 

[Procedure] 

1) Right-click the Windows Start button with the mouse. 

2) Select “Search” from the menu. 

3) Type “TeliViewer” as the search word. 

4) Select TeliViewer from the search result and launch it. 

[Procedure] 

1) Click the "Activities" button on the taskbar or the "Show Applications" icon at the bottom of the Dock. 

2) Type “TeliViewer” as the search word. 

3) Select TeliViewer from the search result and launch it. 

[Procedure] 

1) Open a filer such as Nautilus or a terminal, and then go to /opt/TeliCamSDK/bin. 

2) Execute the script “execute_TeliViewer.sh” to launch TeliViewer. 
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6. Structure of TeliViewer 
The basic structure of TeliViewer is shown in the following figure. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The brief description of each component is following. 

 

① Menu bar 

② Tool bar 

By using these features, various operations are available for the camera and images. Details are explained 

in the following sections on each feature. 

 

③ Main window 

It is placed in the center of the TeliViewer to display the image from the camera. It also supports the feature 

of displaying images from multiple cameras simultaneously, such as “2in1” or “4in1”. Refer to the detailed 

description within “Main window” section. 

 

 

TeliViewer also has small windows for controlling the camera and images, or for displaying information. 

They are called as “Pane” and follows are supported in TeliViewer 

 

④ Discovery 

It supports features such as camera discovery, open/close the camera. Refer to the detailed description 

within “Discovery” section. 

 

① 

② 

③ 

⑤ 

④ 

⑥ 

⑦ 
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⑤ FeatureView 

It displays supported features within camera as the list. It is possible to confirm the current values or change 

the settings for each of features. Refer to the detailed description within “FeatureView” section. 

 

⑥ Status Log 

It lists events that occurred on the TeliViewer. Refer to the detailed description within “StatusLog” section. 

 

⑦ Camera Control Panes 

The most frequently used features for controlling the camera are collected into these panes. Refer to the 

detailed description within “Camera Control panes” section. 

 

 

 

Regarding the setting of  

DeviceUserID 

By using DeviceUserID, user can set a unique ID for each camera. When 

several cameras are available in the system, this makes easier identifying 

the cameras. Also, since TeliViewer uses the DeviceUserID assigned to 

each camera as part of the key to identify them, this setting affects the 

"Save/Restore Camera Settings" and "Save/Restore Line Drawing Status". 

Although this is not a requirement, in advance, it is recommended that 

DeviceUserID should be set appropriately. 

[Note] DeviceUserID can be set from “FeatureView”. 

 

Hint 
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7. TeliViewer features 
This section describes the features supported by TeliViewer. 

 

7.1. Discovery 

It searches cameras that are available on the system and displays them in Camera List. By opening a 

selected camera from the list, the camera becomes available to operate. 

 

 

 

 

 

 

 

 

 

 

 

7.1.1. Updating Camera List 

When the button ① in above figure is pressed, the Camera List is updated. If any camera is newly plugged 

into the system, by pressing this button, it will appear in the list. Also, if any camera is plugged out, by pressing 

this button as well, it will be deleted from the list 

 

7.1.2. Camera Open/Close 

When the button ② is pressed, the camera selected on the Camera List can be opened or closed. The color 

of the button is changed as follows, according to the current state of camera. 

Button state Description 

In case of The selected camera is closed. When this button is pressed, the camera will 

be opened. 

In case of The selected camera is opened. When this button is pressed, the camera is 

closed. 

 

7.1.3. Camera List 

In the camera list ③ in above figure, cameras plugged into system are listed. By clicking the camera with the 

mouse or using the arrow keys on keyboard, users can select the camera to operate. 

 

①  ②  

③  
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Regarding the display order of  

cameras 

The cameras are listed in three categories, such as "U3V devices", "GEV 

devices" and "GenTL devices". In addition, cameras within each category are 

sorted and displayed in ascending order by ModelName + SerialNumber + 

DeviceUserID as the keys. 

Using the context menu 

If right-clicking with the mouse a camera in the list, it will open a context menu 

for opening/closing the camera. By using this, it is possible to perform quick 

operations equivalent to those described in ② above. 

Plugged-in camera does not  

appear in the camera list 

In such case, double-check whether connection between host and camera via 

the cable is correct, and then execute "Update Camera List". If it seems that 

there is no problem in camera connection, and the situation does not recover 

to correct state, refer to the support information on our website. 

 

7.1.4. Open camera with external XML file 

 

 

About this feature 

This feature is intended for developers or specific users. If incorrect XML file is 

loaded, it may cause problems such as failure to configure the camera. So, it is 

required to pay attention for using this feature. 

 

By right-clicking a camera in the list, the context menu will appear as following figure. By selecting this menu, 

the camera can be opened using an XML file stored in the local storage on the host. 

 

 

By selecting this menu item, dialog to specify the XML file will be opened. Then, select the XML file and 

execute the steps to open the camera. Note that user must use correct XML file that matches to the current 

camera. Otherwise, the camera becomes out of control, as the result of loading incorrect XML. 

 

 

In case incorrect XML file was 

loaded 

The camera will return from failure to correct state if camera is closed and 

reopened, with procedure written in “Camera Open/Close”. 

Procedure for saving XML file  

from camera to local storage 
Refer to sentence within “Save XML to file”. 

 

7.1.5. Features for GigE camera 

The descriptions in this sentence are only available for GigE camera. 

In the Camera List described as ③ above, by right-clicking a GigE camera with the mouse, that is listed in the 

"GEV devices" category, the following context menu will appear, and it is available to setup the GigE camera. 

Hint 

Attention 

Hint 
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7.1.5.1. Access mode selection 

It is available to select Access mode for a GigE camera with menu as following figure. Default setting is 

Control access. Basically, it is recommended to use with default setting. 

If user need to change the settings by any reason, select the appropriate mode from following menu, and 

then execute the steps to open the camera. 

 

 

 

 

 

 

Details of each mode are described in following table. 

Access mode Description 

Exclusive 

Camera is opened with exclusive access rights. Then, registers on camera 

can be accessed with RW permission. If it is opened with this mode, it 

becomes to be inaccessible from other hosts. 

Control 

Camera is opened with control access rights. Then, registers on camera can 

be accessed with RW permission. If it is opened with this mode, accessing 

from other hosts is limited with RO permission. 

Monitor 

Camera is opened with monitor access rights. Then, since registers on 

camera can be accessed with RO permission, this host cannot write and 

change any setting on camera. This mode should be used when the camera is 

already opened from other host, with the control access rights, and it is 

needed to access from this host to such camera, with RO permission. 

Basically, monitor access is used to open the camera as a listener, when 

“Multicast” is activated. 

 

7.1.5.2. Launch “IP Configuration tool” 

From following context menu, it is available to launch the external tool, such as “IP Configuration tool”. 

 

 

 

 

 

 

This allows users to change the IP address settings for the GigE camera on current network. Note that “IP 

Configuration tool” can change the settings of products of Toshiba Teli only. 

 

7.2. Main window 

Main window is a centrally placed window for displaying camera images. It supports various features to 

assist users, such as zoom in/out, drawing lines on the image, or etc. Also, it supports the “Multi display” 

feature, which allows to display multiple camera images on a single screen, such as 2in1/4in1. 

The following descriptions explain how to use these features. 
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7.2.1. Control for stream 

This section describes the operations for streaming from the camera. The basic controls can be operated 

from the toolbar as following. 

 

 

 

 

7.2.1.1. Start 

By pressing the button ① in above figure, streaming is started with current camera. 

 

7.2.1.2. Pause 

By pressing the button ② in above figure, updating of images is temporarily paused. Even if it is paused, 

capturing of images from camera is continued. This feature is useful when user need to confirm the actual 

capture rate from camera, without any overhead relating to image rendering. 

If this button is pressed again, updating of images is resumed immediately. 

 

7.2.1.3. Stop 

By pressing the button ③ in above figure, streaming is stopped. 

 

 

Using the context menu 

When the camera is already opened, to right-click the image display area 

with the mouse displays a context menu for controlling the stream as 

following figure. 

 

 

 

 

By using this, it is possible to perform quick operations for streaming, such 

as Start/Pause/Stop. 

 

7.2.2. Scroll feature 

When part of the camera image is outside the current display area, the scroll feature enables users to view 

and confirm the outlying image area. This feature is supporting 2 modes as follows. Users can select 

appropriate mode for current situation or preference. It is selectable on toolbar after stream is started. 

 

 

 

 

7.2.2.1. Drag mode 

By pressing the button ① in above figure, scroll mode will be changed to drag mode. When this mode is 

selected, users can scroll the image by following steps. 

Additionally, if this button is pressed again, the drag mode will be turned off. 

 

③  ①  ②  

① ② 

Hint 
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7.2.2.2. Auto mode 

By pressing the button ② in above figure, scroll mode will be changed to auto mode. When this mode is 

selected, moving the mouse cursor to any point on the camera image will bring automatically scrolling, in sync 

with the cursor movement.  

Additionally, if this button is pressed again, the auto mode will be turned off. 

 

 

Using the context menu 

When the camera image is displayed, right-clicking on the image area 

with the mouse displays a context menu for switching the scroll mode, as 

following figure. 

 

 

 

By using this, it is possible to perform quick operations for selecting scroll 

mode, such as Drag/Auto or turning off them. 

 

7.2.3. Zoom feature 

This section describes operations to zoom in or out the camera image. Basically, operations can be done 

from the toolbar. In addition to that, if a wheel-equipped mouse is connected to the host, user can also use this 

wheel to zoom in/out.  

The available range for zoom is from 3% to 800%.  

 

 

 

 

7.2.3.1. Using the slider 

By dragging the handle (knob) with the mouse, on the slider ① in above figure, the value can be changed 

continuously. Also, by clicking on the guide areas, users can change the zoom setting in smaller steps.  

The changed result is automatically reflected to ④ in above figure. By the value of ④, users can confirm the 

current actual value anytime. 

 

7.2.3.2. Fit mode 

By pressing the button ② in above figure, image is displayed with Fit mode. In Fit mode, the image is 

continuously displayed under the following conditions. 

① 
② ③ ④ 

[Steps] 

1) When the mouse cursor is on the camera image, confirm that the cursor shape is the same 

as the "palm" as shown in the above figure ①. 

2) Click anywhere on the camera image with the left mouse button. 

3) Move the mouse with dragging to scroll the image. 

4) Release the left mouse button. 

5) Move to the target coordinate by repeating the above steps 2 to 4. 

Hint 
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Image Direction Display Effects 

Vertical Fit image to height of display area 

Horizontal Centering image to display area 

Even if display area is resized, image will be displayed with above conditions. Additionally, Fit mode will be 

canceled forcedly, by pressing ①, ③, ④ in above figure, or the result of operating Ctrl key + mouse wheel, as 

described in this section.  

 

 

Using the context menu 

When the camera image is displayed, right-clicking on the image area 

with the mouse displays a context menu for changing into the Fit mode, 

as shown in following figure. 

 

 

By using this, it is possible to perform quick operations for changing into 

this mode. 

 

7.2.3.3. Actual size (100%) 

By pressing the button ③ in above figure, image is displayed with actual size (Zoom: 100%). 

 

 

Using the context menu 

When the camera image is displayed, right-clicking on the image area 

with the mouse displays a context menu for displaying the image with 

actual size, as shown in following figure. 

 

 

By using this, it is possible to perform quick operations for changing the 

magnification to actual size. 

 

7.2.3.4. Using the spin box 

By using the spin box ④ in above figure, it is available to enter values directly, or to change values in small 

steps using the spin buttons. 

If value is changed by this method, the changed result is automatically reflected into ①. 

 

7.2.3.5. Using the Ctrl key + mouse wheel 

[Note] It is required a wheel-equipped mouse to accomplish this operation. 

After clicking on an image area, the image can be zoomed in or out by holding down the Ctrl key on 

keyboard and moving the mouse wheel up or down. 

Operation Effects 

Ctrl key + mouse wheel Up Zoom in the image 

Ctrl key + mouse wheel Down Zoom out the image 

 

 

Hint 

Hint 
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7.2.4. Save image to file 

The currently displayed image can be saved as a still image. To save the image, click the following button on 

the toolbar. 

 

 

 

7.2.4.1. Dialog for save 

By pressing the button ① in above figure, following dialog will appear. 

 

 

 

 

 

 

 

 

7.2.4.2. Save the lines on image 

When Grid or 4x4 is enabled with “Draw lines on image” setting, check box ② in above figure is available. 

By checking it, the lines drawn on current image can be saved to a file,. 

 

 

Saving the image with RAW 

format 

Note that if "RAW" is selected for file format, any lines drawn on current image 

cannot be saved to the file. 

 

7.2.4.3. Setting for save 

By pressing the button ③ in above figure, the dialog as following is displayed. In this dialog, it is available for 

users to select the folder, filename, and file format. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 

Attention 
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7.2.4.4. Folder 

By using ④ in above figure, users can select the folder on the host, where the file is to be saved. 

 

7.2.4.5. Filename 

By using ⑤ in above figure, users can specify the filename to be saved. Initially, the filename is shown in 

"Image_yymmdd_hhmmss" style.  

(yymmdd: Date when ③ was pressed; hhmmss: Time when ③ was pressed) 

 

7.2.4.6. File format 

By using ⑥ in above figure, users can select a format from 4 types in following table. 

Format Description 

PNG 
Image is saved as PNG format. 

Bit depth can be selected from 8, 16, 24, 32, or 48 bpp. 

JPG Image is saved as JPG format. 

BMP 
Image is saved as BMP format. 

Bit depth can be selected from 8, 24, or 32 bpp. 

RAW Image is saved as RAW format. 

 

7.2.4.7. Header of RAW format 

When the image is saved with RAW format, the beginning of the saved file contains 32 bytes of header 

information as follows. The actual image data is stored immediately after it. 

Structure 
Size 

(Byte) 
Description 

Flag 4 0x00574152 indicating RAW format is always stored. 

File size 4 Size of this file. 

Image format 4 Image format stored in this file. 

Width 4 Width of image. 

Height 4 Height of image. 

Reserved 12 This field is reserved for future extension. 

 

7.2.4.8. Save button 

By pressing the button ⑦ in above figure, image data is saved into file with specified condition. 

https://www.toshiba-teli.co.jp/en/
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Working with trigger mode 

By using the trigger mode, user can explicitly capture the still images. If 

necessary, user can use it within “Trigger” pane of “Camera Control 

panes”. 

 

 

7.2.5. Loupe 

Loupe tool is available to enlarge the part of image. It enlarges as doubled size of the image, in current 

cursor position. 

 

 

 

7.2.5.1. Launch of Loupe 

By pressing the button ① in above figure on toolbar, Loupe tool is launched. Loupe is moved in sync with 

current mouse cursor. When this button is pressed again, Loupe is closed. 

Following figure is showing the overview when it is enabled, and image is enlarged. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Using context menu 

When the camera image is displayed, right-clicking on the image area 

with the mouse displays a context menu for launching the Loupe, as 

shown in following figure. 

 

 

By using this, it is possible to perform quick operations for it. 

 

① 

Partial image 

enlarged by Loupe 

Hint 

Hint 
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7.2.6. Draw lines on image 

This feature is available for drawing the lines on current image. By selecting the menu ① on menubar, or 

button ② on toolbar as following figures, users can draw them. The same dialog will appear for both 

selections. 

 

 

 

 

 

The above operation opens the "Grid/4x4 Settings" dialog, and the usage for each of “Grid” and “4x4” is 

following. 

 

7.2.6.1. Grid  

By selecting the “Grid Settings” tab on the “Grid/4x4 Settings” dialog, the following dialog will appear. In 

addition, the image on the right shows the actual image with the Grid lines, according to the current settings. 

The width of lines is fixed as 1Pixel. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① Draw Grid check box 

When it is checked, Grid lines are drawn on current image. 

② Horizontal Pitch 

It specifies the pitch of horizontal lines. The unit of the value is pixel. 

③ Vertical Pitch 

It specifies the pitch of vertical lines. The unit of the value is pixel. 

④ Color 

When this button is pressed, the dialog for selecting the color is displayed. Users can change the color of 

them by it. 

① or ② 

① 

② 

③ 

④ 

Horizontal 

Pitch 

Vertical 

Pitch 
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7.2.6.2. 4x4 

By selecting the “4x4 Settings” tab on the “Grid/4x4 Settings” dialog, the following dialog will appear. By 

using this feature, four horizontal lines and four vertical lines can be drawn on the image. In addition, the 

image on the right shows the actual image with the 4x4 lines, according to the current settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① Draw 4x4 check box 

When it is checked and additionally following ② or ③ is checked, each 4x4 lines are drawn on current 

image. 

② H1～H4 (Horizontal Line #1～#4) check box 

When it is checked, horizontal line is drawn. After checking the above “①: Draw 4x4 checkbox”, check 

any of H1～H4 to draw the corresponding horizontal line.  

③ V1～V4 (Vertical Line #1～#4) check box 

When it is checked, vertical line is drawn. After checking the above “①: Draw 4x4 checkbox”, check any of 

V1～V4 to draw the corresponding vertical line. 

④ Position 

It can specify the position of each line. The unit of the value is pixel. The setting and effects for horizontal 

and vertical lines are following. 

Position setting Effects 

H1～H4 
Draw the horizontal line according to current setting, for position based on the upper left corner 

of the image. It is drawn on specified pixel position toward Y-axis. 

V1～V4 
Draw the vertical line according to current setting, for position based on the upper left corner of 

the image. It is drawn on specified pixel position toward X-axis. 

⑤ Width 

It specifies the width of each line. The unit of the value is pixel. The available range is from 1 to 10. 

⑥ Color 

When this button is pressed, the dialog for selecting the color is displayed. Users can change the color of 

them by it. 

 

① 

② 

③ 

④ ⑤ 
⑥ 
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7.2.6.3. Move 4x4 by mouse drag 

Each 4x4 line drawn in the image can be moved by dragging with the mouse. Refer to the following procedure 

to move them. 

  

[Steps] 

1) Draw 4x4 lines according to the “4x4” procedure described in the previous section. 

2) Move mouse cursor on 4x4 lines drawn on image. 

3) Click the line with left mouse button and drag to move it. 

4) When it has finished to move the line to the desired position, release the left mouse button. 

5) With the above operations, the line can be moved to any desired position on the image. 

 

 

 

Under the drag mode 
This feature is not available under the “Drag mode”. Drag mode should 

be disabled to use this feature. 

 

 

 

Using context menu 

When the camera image is displayed, right-clicking on the image area 

with the mouse displays a context menu as following. 

 

 

 

 

1) Draw Grid 

Grid can be turned on and off by this. The effect is the same as if 

the operation ① had been done in the “Grid” description. 

2) Draw 4x4 

4x4 can be turned on and off by this. The effect is the same as if 

the operation ① had been done in the “4x4” description. 

3) Grid/4x4 Settings 

“Grid/4x4 Settings” dialog can be opened. 

By using this, it is possible to perform quick operations for Grind/4x4. 

Regarding save and restore  

Grid and 4x4 settings 

When the check box of “Save and Restore Grid/4x4 settings” in options 

dialog is checked, it is enabled to save and restore current line drawing 

states. Saving the settings is executed when the camera is closed, and 

data is saved into “Line configuration file”. 

Also, data is restored when the camera is opened. If a “Line configuration 

file” exists that matches the three keys "ModelName / SerialNumber / 

DeviceUserID" of the current camera, it will be restored. 

 

 

Note that if the DeviceUserID of the camera is changed, it will no longer 

match the DeviceUserID stored in the “Line configuration file”. As the 

result, previously saved data will not be restored. 

 

Attention 

Hint 

Attention 
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7.2.7. Tab control 

When the screen is displayed in normal mode (not multi-display) and multiple cameras are opened, tabs as 

following figure will appear at the top of the display area. This section describes the operation for tabs. 

 

 

 

 

7.2.7.1. Change current camera 

By left-clicking on a tab with the mouse, camera selection can be changed. 

 

7.2.7.2. Tab detachment 

Tabs can be detached by double-clicking on them. As the result, camera image is displayed with independent 

window. By utilizing this feature, the image display area can be arranged in a layout for user’s preferences. 

Also, double-clicking on the title bar of a detached window will re-tab it and return it to its original state. 

 

7.2.8. Multi display 

By clicking the “Multi-Display” on menubar, it is available to utilize 2in1 or 4in1 mode as following figure. By 

selecting one of these options, multi-display mode will be activated. 

In following figure, 2in1 is checked and the viewer is working in 2in1 mode. If this is clicked again, the 

checked state is cancelled, and TeliViewer returns to normal mode. This operation is same for 4in1. 

 

 

 

 

 

 

 

Attention for changing mode 
Note that if the mode is changed when the camera is open, all opened cameras 

will be forced to close. 

Regarding the requirements  

for Multi-Display mode 

Streaming multiple cameras with “Multi-Display” modes simultaneously requires 

high hardware performance. Please refer to the description in “Operation 

Environment” for requirements, etc. 

 

7.2.8.1. 2in1 

By selecting ① in above figure, TeliViewer will enter into 2in1 mode. In 2in1 mode, two camera images can 

be displayed simultaneously in the main window. 

The following section describes the procedure for displaying camera images in 2in1 mode. 

① 

② 

Attention 
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[Steps] 

1) By using the mouse, select any of the divided image display areas. The selected area (Current Area) is 

encircled by a red frame. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2) Open the camera to the Current Area according to the procedure “Camera Open/Close” in Discovery. 

3) Start streaming to the opened camera in the Current Area with the “Start” procedure of the stream 

operation. 

4) By using the mouse, select the area where the camera is not open and change the Current Area. 

5) Repeat steps 2) to 4) above to start streaming for all cameras for which images are to be displayed. 

 

7.2.8.2. 4in1 

By selecting ② in above figure, TeliViewer will enter into 4in1 mode. In 4in1 mode, four camera images can 

be displayed simultaneously in the main window. 

The following section describes the procedure for displaying camera images in 4in1 mode. 

 

[Steps] 

1) By using the mouse, select any of the divided image display areas. The selected area (Current Area) is 

encircled by a red frame. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Current Area 

Current Area 
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2) Open the camera to the Current Area according to the procedure “Camera Open/Close” in Discovery.  

3) Start streaming to the camera in the Current Area with the “Start” procedure of the stream operation. 

4) By using the mouse, select the area where the camera is not open and change the Current Area. 

5) Repeat steps 2) to 4) above to start streaming for all cameras for which images are to be displayed. 

 

 

Using context menu 

Quick operation for  

camera open 

When the camera is not open, right-clicking on the 

Current Area displays the Camera Open menu as 

following. 

 

 

 

 

By using this, it is possible to perform quick operations 

for opening the camera. Even in full screen mode, 

where the Discovery pane is not displayed, this can be 

used to open the camera. 

Quick operation for  

camera close 

When the camera is open, right-clicking on the Current 

Area displays the Camera Close menu as following. 

 

 

By using this, it is possible to perform quick operations 

for closing the camera. For example, if users want to 

change the positioning of the camera while in full screen 

mode, users can use this and the open context menu as 

above to change it easily. 

Focusing the display 

on a specific camera in 

2in1/4in1 mode 

When the camera image is displayed, right-clicking on 

the image area with the mouse displays a context menu 

as following. 

 

 

By using this, the current image can be displayed alone 

in full screen mode. Use this option when users want to 

focus on a specific image. 

How to display or hide the scroll 

bar 

Refer to the “Display Scrollbar” description for the scroll bar display settings within 

each of the divided image display areas. 

 

 

Scroll bar is not available under the “Fit mode” mode. 

How to display or hide the  

current frame rate, coordinate  

information, and RGB values 

For the information display, “TabBar” or “Overlay” can be selected. It is possible 

to choose the most suitable method according to user’s preferences. 

 

Hint 

Attention 
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7.2.9. Full Screen display 

By pressing the Full Screen button on the toolbar, the image can be displayed in Full Screen mode. 

 

 

 

7.2.9.1. Start Full Screen 

By pressing ① in above figure, the current main window can be displayed in Full Screen. It is available in 

following conditions. 

Display mode Effects 

Normal 
When the camera image is displayed in normal mode, pressing ① will 

display the current image in Full Screen. 

2in1 
When the camera image is displayed in 2in1 mode, pressing ① will 

display the 2in1 image in Full Screen. 

4in1 
When the camera image is displayed in 4in1 mode, pressing ① will 

display the 4in1 image in Full Screen. 

 

7.2.9.2. End Full Screen 

When the ESC key is pressed, the Full Screen returns to the previous screen. 

 

① 
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7.2.10. Image Settings 

By selecting the [Image] → [Settings] option in menubar, Image Settings dialog will appear as following. 

In this dialog, configuration settings for image rendering can be changed. 

 

 

 

 

 

 

 

 

 

 

 

 

7.2.10.1. Bayer convert option 

When the image format is Bayer type, pixel interpolation method can be changed with this option. It is 

possible to select from three types: Bi-Linear, ACPI, or No conversion. Default setting is Bi-Linear. 

 

 

Regarding the ACPI method 
ACPI is only available with Bayer 8 bit. If current pixel format is Bayer 10 or 12 bit,  

ACPI is not selectable. 

 

7.2.10.2. Interpolation display method 

When the image is zoomed in or out, pixel interpolation method can be changed with this option. It is 

possible to select from two types: Nearest neighbor or Bi-Linear. Default setting is Nearest neighbor. 

 

7.2.10.3. Set maximum display rate 

It is possible to set the upper limit of the Display Rate. For example, in environments with low hardware 

performance, when the Capture Rate does not achieve the maximum camera FPS, it is typically due to system 

resources being drained by stress from the image rendering. In that case, by limiting the upper limit of the 

Display Rate, users can ensure that “maximum Display Rate with keeping the maximum Capture Rate” in 

current environment. 

Specifically, refer to the following procedure. 

 

 

 

 

 

 

 

[Note] The maximum value that can be set here depends on the refresh rate of the monitor hardware 

currently in use. 

 

[Steps] 

1) Check the check box of “Set maximum display rate” 

2) Input Zero to spin box 

3) Confirm the Capture Rate 

4) Increase the value of the spin box in small steps by about 1 or 2 

5) Repeat steps 3 through 4 above to find a Display Rate that can keep the maximum Capture Rate 

Attention 
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7.2.10.4. Image processing 

It is possible to select whether the image conversion is to be processed by the CPU or the GPU. Default 

setting is GPU.  

Basically, by processing the images in GPU mode, the CPU stress can be kept low. As the result, the impact 

on other processes is reduced, and the entire system may be run more smoothly. So, it is recommended that 

users should work with GPU mode. Only if user meet any problem in displaying images while using the GPU 

mode, it is recommended to switch to the CPU mode as the workaround and confirm whether there is any 

improvement. 

[Note] In some environments such as graphic driver without OpenGL support is installed, users cannot 

select the GPU mode. In that case, it will automatically work in CPU mode. 

 

 

In case there is no difference in 

CPU stress between GPU and 

CPU mode 

If the appropriate driver is not installed for the graphics card currently 

within your system, there is a possibility that the GPU processing will not 

work correctly. For information on how to install the most appropriate 

driver, refer to the website of vendor of graphics card. 

 

Hint 
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7.3. FeatureView 

This displays a list of features supported by the camera that is currently opened. It displays the current value 

of each feature and if it is editable, provides a method for editing. 

FeatureView is consisted with the ToolBar, FeaturesList, FavoritesList, and Description area. The following 

section describes the usage of these components. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.3.1. ToolBar 

ToolBar is consisted with following features. This section describes how to operate each of them 

implemented here. 

 

 

 

 

 

 

 

7.3.1.1. Reload 

By pressing ① in above figure, the FeaturesList and FavoritesList will be updated to the current value. 

① ② ③ ④ ⑤ 

⑥ ⑦ 

⑧ ⑨ 

ToolBar 

FeaturesList 

FavoritesList 

Description 
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7.3.1.2. Format Selection 

By selecting ② in above figure, the display format of the FeaturesList can be changed as follows. 

Buttons Effects 

button Display by category. 

button Sort and display in alphabetical order 

 

7.3.1.3. Filter Selection 

By changing the selection of ③ in above figure, it is possible to filter the items that are displayed in 

FeaturesList. Each item supported by the camera has the attribute of Beginner/Expert/Guru, and the 

display of FeaturesList can be switched by selecting one of the follows. 

Display Mode Effects 

button Beginner mode. 

It displays the items only for Beginner. 

button Expert mode. 

It displays the items for Beginner and Expert. 

button Guru mode. 

It displays the items for Beginner, Expert and Guru. 

 

7.3.1.4. Enable FavoritesList 

By pressing ④ in above figure, toggles the FavoritesList pane ON or OFF. When it is ON, FavoritesList is 

available. 

 

7.3.1.5. Save/Load camera features 

By pressing ⑤ in above figure, submenu for saving or loading the settings of camera features will appear 

as following figure. This section describes how to use them. 

 

 

 

 

 

 

(A) 

(B) 
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7.3.1.5.1. Load features 

By selecting (A) in above figure, following dialog is opened. It is possible to load the camera settings by 

selecting a file that was previously saved in the “Save features” steps. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In case the camera is in  

streaming 

The Load feature is not available when the camera is in streaming mode. It is 

required to stop the camera streaming at once before using Load feature. 

In case the configuration 

file with different model  

name is selected 

If a configuration file with a model name different from the currently opened 

camera is attempted to load, warning will be displayed as following. 

 

 

 

 

 

 

 

In this case, it is recommended to abort the operation by pressing Cancel. If OK is 

pressed to continue, the loading will fail in most cases and cause unexpected 

result. Although it is possible to continue by pressing OK, note that if the camera 

becomes abnormal state as the result, it is the user's responsibility. 

In case the incorrect file  

was loaded 

If the incorrect file is loaded, the camera will fall into abnormal state as the result. 

In such case, the camera can be recovered to its initial state by re-plugging or 

executing Device Reset. 
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7.3.1.5.2. Save features 

By selecting (B) in above figure, the camera settings can be saved into a file with following dialog. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➢ Filename 

(C) displays the initial string of file names. The string is constructed from “(ModelName)_(Serial 

Number)_(DeviceUserID)”. If needed, the name can be changed to another one according to user’s 

preferences. 

➢ File format 

In (D), only the tcf (TELI camera features) format can be selected. Only this format can be loaded by 

steps (A) in above description. 

 

 

In case using CoaXPress  

camera 

Under the CoaXPress, there are two types of settings: those belonging to the 

camera and those belonging to the capture board. Note that only the limited 

number of capture board settings will be saved into the file but not all settings.  

 

(C) 

(D) 

Attention 
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7.3.1.6. Save XML to file 

By pressing ⑤ in above figure, submenu for saving the XML file is displayed. It allows users to save XML 

data of currently opened camera into the file. 

 

 

 

 

 

 

By selecting (C) in above menu, dialog for saving the XML file is displayed. Then, select the filename and 

folder, and click the [Save] button to save the file. 

 

7.3.1.7. Access module selection 

[Note] This feature is only available when current camera is GenTL device. When current camera 

is USB3 or GigE, it is N/A. 

By changing the selection of ⑥ in above figure, the setting items for each module can be selected. 

Items Description 

RemoteDevice 
Displays items categorized as RemoteDevice. 

They are settings for the camera. 

System 
Displays items categorized as System. 

They are settings for the capture board. 

Interface 
Displays items categorized as Interface. 

They are settings for the capture board. 

Device 
Displays items categorized as Device. 

They are settings for the capture board. 

Stream 
Displays items categorized as Stream. 

They are settings for the capture board. 

 

7.3.1.8. GenICam cache setting  

By changing ⑦ in above figure, the GenICam cache can be turned ON or OFF. 

This is a setting for developer. Default setting is ON. Basically, it should be left ON. 

For example, if it is needed to reflect the current value in the FeaturesList or FavoritesList after writing the 

value directly to the camera register, by using the Write command, turn off this check box and then press the 

Update button ①. By this operation, the current value stored in the camera register can be directly read out, 

instead of the value stored in the cache. 

[Note] If it is used with the OFF setting, I/O performance with the camera may be slower. 

 

7.3.1.9. String search 

By entering the string into ⑧ in above figure, it will search the items in FeaturesList with case-insensitive 

condition. In FeaturesList, all items that partially contain the entered string are searched, and the search 

results are displayed. 

(C) 
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7.3.1.10. Delete button for string search 

By pressing the button ⑨ in above figure, the all text entered into the string search will be deleted. 

Also, pressing Ctrl key + Del button works as a shortcut key for this feature. 

 

7.3.2. FeaturesList 

The supported features in current camera are displayed as following list. 

 

 

 

 

 

 

 

 

 

 

 

 

7.3.2.1. Color of feature in list 

Each feature in the list is displayed in a different color. The meaning of each color is following. 

Color Details 

Black 
Indicating that the attribute of the item is RW (ReadWrite). The value can be 

edited. 

Brown 
Indicating that the attribute of the item is RO (Read-Only). The value cannot be 

changed. 

Green 
Indicating that the attribute of the item is WO (Write-Only). When an editor for 

this feature is opened, a command button will appear. 

 

7.3.2.2. How to change the value 

If the attribute of the feature is RW or WO, it can be edited by opening a user interface for changing the value. 

This user interface is called as Editor. The following describes how to use it. 

 

7.3.2.2.1. How to open/close the Editor 

Editor can be opened or closed with following operation. When Editor is open, the value is editable. 

Purpose Operations 

Open the Editor 
・Left-click the value with mouse 

・With the feature on the "Name" column selected, press the right arrow key 

Close the Editor 

・Left-click with mouse anywhere other than the opened editor 

・Press Enter key 

・Press ESC key 
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7.3.2.2.2. How to input to Editor 

The following types of editors are available. This section describes how to change each value. 

Type of Editor Descriptions 

Line editor 

Integer values, floating-point values, and character strings can be entered 

directly. For GigE cameras, IP addresses can also be entered by it. 

The format of the values that can be entered depends on each feature. For 

details, refer to the instruction manual of current camera. 

Drop-down list 
By opening the editor, a list of selectable values is displayed. Users can 

select the value from it. 

Command button By pressing the displayed button, the selected operation is executed. 

Composite editor 

In this editor, both line editor and slider are available like following figure. 

Use these editors appropriately according to user’s preferences. 

 

 

・Using the Tab key 

Additionally, instead of using the mouse, it is possible to switch the focus 

between the line edit and the slider by pressing the Tab key or Shift+Tab 

key. 

 

 

 

 

 

7.3.3. FavoritesList 

By registering frequently used features into FavoritesList, users can quick access to them. The all features 

registered here will be restored at the next launch of TeliViewer. 

 

 

 

 

 

 

 

 

 

 

 

7.3.3.1. Add feature 

By selecting a feature on the “FeaturesList” and press ① in above figure, it will add the feature to the 

FavoritesList. 

 

7.3.3.2. Remove feature 

By selecting a feature on the FavoritesList and press ② in above figure, it will remove the feature from the 

FavoritesList. 

① ② ③ 

④ 

Changing the focus by Tab key 

Hint 
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7.3.3.3. Remove all features 

If button ③ in above figure is pressed, all features in FavoritesList will be deleted. 

 

7.3.3.4. Sort features 

After selecting a feature on the FavoritesList, users can move it up or down, by clicking the up or down arrow 

button ④ in above figure. Items can be sorted in any order by user’s preferences. 

 

7.3.3.5. How to change the value 

The method of editing a value is the same as on the FeaturesList. For more information, refer to “How to 

change the value”. 

 

7.3.4. Description pane 

When any feature is selected on the FeaturesList or FavoritesList, detailed description of the feature will be 

displayed in this pane as following figure. If it is needed to know more about each feature, refer to it. 

 

 

 

 

 

 

Show tool tip ① 

(Feature name and description) 

When mouse cursor is moved over the name in FeaturesList or FavoritesList, a 

tool tip will appear as following. 

 

 

 

 

 

 

It is possible to see the entire name of a feature even if it is partially hidden. Also, 

a brief description of it will be displayed for reference. 

Show tool tip ② 

(Info for settable values) 

If a feature has the predefined value range, moving the mouse cursor to the 

Editor will display the Min/Max/Inc values as following. 

 

 

 

It is available to confirm the range of values that can be set. 

Using context menu 
Add feature to  

FavoritesList 

By right-clicking a feature in FeaturesList, context 

menu is displayed as following. 

 

 

It is possible to use it for quick registration to the 

FavoritesList. 

Hint 
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Operation for  

FavoritesList 

By right-clicking a feature in FavoriresList, context 

menu is displayed as following. 

 

 

 

 

 

It is possible to perform quick operations for sorting 

or removing the feature in FavoritesList. 

 

7.4. StatusLog 

It lists the events occurred in TeliViewer. 

 

 

 

 

 

 

 

 

 

 

7.4.1. Clear Event list 

When button ① in above figure is pressed, all events displayed in the event list will be cleared. 

 

7.4.2. Event filter selection 

By pressing any button ② in above figure, it is possible to filter the events displayed. 

Filter Effects 

button Displays Error information. It corresponds to an event type of ERR. It is an 

error that prevents to continue the processing. 

button Displays Warning information. It corresponds to an event type of WRN. It is a 

warning that can continue the processing. 

button Displays Info information. It corresponds to an event type of INFO. It is 

information but not error such as status change or else. 

 

① ② 

③ 

④ 
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7.4.3. Details of Event list 

In field ③ in above figure, each listed event is consisted with following information. 

Item Descriptions 

Data/Time Indicates the date and time of the event. 

Camera 
Indicates the ModelName, SerialNumber and DeviceUserID of the camera that the 

event occurred on. 

Type 
Indicates the type of event that occurred. As described in the previous section, there 

are three event types: ERR/WRN/INFO. 

Code Indicates the event code. 

Message Indicates the detailed description of the event. 

 

7.4.4. Save events 

By pressing the button ④ in above figure, a dialog to save the all events currently displayed in ③ will be 

opened. It can save them into CSV file. User can use it to analyze them on demand. 

 

7.5. Camera event 

By this pane, event from camera can be retrieved and displayed. It can be opened by selecting [View] → 

[Camera Control] → [Camera Event] on toolbar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.5.1. Clear camera events 

When button ① in above figure is pressed, all events displayed in the event list will be cleared. 

 

① ② ③ ④ ⑤ 

⑥ 
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7.5.2. Turn ON/OFF camera event 

By pressing the button ② in above figure, user can switch ON or OFF the camera event. The status of 

button will be changed as follows as toggle. 

Status Effect 

button It means camera event is disabled. If the button is pressed, camera 

event becomes enable, and status of button will be changed as 

following. 

button It means camera event is enabled. If the button is pressed, camera 

event becomes disable, and status of button will be changed as 

above. 

 

7.5.3. Select camera event 

By pressing the button ③ in above figure, a dialog as following will be displayed. This dialog shows the 

available events in current camera. By checking each checkbox on dialog, user can select the camera event to 

be retrieved  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Regarding the selectable event 

The selectable event here is different in each camera model. If it is required to 

know the more detailed information for each event, users can confirm it with user 

manual for current camera. It can be downloaded from our website. 

 

 

If several events are selected 

at the same time 

The CPU load will be increased due to increasing the number of events 

received. As the result, the capture or display rate will be decreased. If user want 

to avoid this situation, please enable the minimum number of events required. 

 

7.5.4. Save camera events in list 

By pressing the button ④ in above figure, a dialog to save the all events currently displayed in ⑥ will be 

opened. It can save them into CSV file. User can use it to analyze them on demand. 

 

Hint 

Attention 
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7.5.5. Option settings 

By pressing the button ⑤ in above figure, a dialog “Event Display options” as following will be displayed. 

User can configure the display settings for the events shown in ⑥ as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Item Description 

① Update interval of list 
It specifies refresh interval of the list in milliseconds, which can be set between 

100 and 3000 milliseconds. The default is 500 milliseconds. 

② Maximum events in list 
It specifies the maximum number of events to be displayed in the list, which can 

be set between 10 and 1000. The default is 200 events. 

③ Event display format 

It specifies the event display format. User can select from any of the following. 

➢ Code 

Displays event code only. 

➢ String 

Displays the event name string. 

➢ String + Code 

Displays the event name string and event code at the same time. 

④ Timestamp display format 

It specifies the timestamp display format. User can select from any of the 

following. 

➢ Hexadecimal 

Displays in hexadecimal. 

➢ Decimal 

Displays in decimal. 

 

 

 

Regarding settings ① or ② 

If the setting value of ① is decreased or the setting value of ② is increased, the 

CPU load for the list update process will increase. Note that, as a result, capture 

rate or display rate will be decreased. 

 

① 

② 

③ 

④ 

Attention 

https://www.toshiba-teli.co.jp/en/


 

 

 

 

40 

Copyright © 2021 - 2023 Toshiba Teli Corporation, All rights reserved. https://www.toshiba-teli.co.jp/en/ 

 

 DAA04027A 

7.5.6. Camera evet list 

The events retrieved from the camera are displayed in ⑥, in the order which they were received. The one 

line displays the information for one event. The events are displayed in the following format. 

 

[Date and time of event acquisition], [Camera identification], [Event], [Timestamp] 

 

Item Description 

Date and time of event 

acquisition 
It indicates the date and time on the host terminal side at which the event was acquired. 

Camera identification 
It indicates information to identify the camera that sent the event, consisting of 

ModelName + SerialNumber + DeviceUserID. 

Event 
It indicates the event acquired from the camera. It is displayed in the format specified in 

③ under “Option settings”. 

Timestamp 
It indicates the Timestamp information transmitted from the camera. The display format 

can be selected from either decimal or hexadecimal using ④ under “Option settings”. 

 

7.6. Camera Control panes 

TeliViewer is supporting Camera Control panes that provide the method for quickly accessing to frequently 

used features. 

The following describes the explanation for using them and recommended usage. 

 

7.6.1. Type of panes 

The following type of panes are supported in TeliViewer. 

Pane Descriptions 

Image Format 
PixelFormat, Width/Height and else can be controlled in this pane. It supports to control 

the features relating to Image Format. 

Image Correction 
Gain, Gamma, WhiteBalance and else can be controlled in this pane. It supports to 

control the features relating to Image Correction. 

Color Masking 
Color Masking can be controlled in this pane. 

[Note] This pane is only available for the camera that is supporting the Color Masking. 

Exposure Exposure and relating features can be controlled in this pane. 

Acquisition Acquisition and relating features can be controlled in this pane. 

Trigger Trigger and relating features can be controlled in this pane. 

UserSet UserSet and relating features can be controlled in this pane. 

GEV Setting The features relating to GigE camera can be controlled in this pane. 

U3V Info The information relating to USB3 camera can be shown in this pane. 

Register R/W Register Read/Write can be executed in this pane. 
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7.6.2. Display the details of feature 

When mouse cursor is moved over the label of each feature, the details of feature will be displayed as the 

tooltip. Users can confirm the brief description for the feature by it.  

For example, when mouse cursor is moved over the label of Gain, tooltip is displayed as following figure. 

 

 

 

 

 

 

In case the more detailed  

information for each feature is  

required 

If it is required to know the more detailed information for each feature, 

users can confirm it with user manual for current camera. It can be 

downloaded from our website. 

 

7.6.3. Display the settable value range 

When mouse cursor is moved over the slider of edit box of each feature, the value of Min/Max/Inc is 

displayed as following figure. Users can confirm the settable value range for the feature by it. 

For example, when mouse cursor is moved over the Width, they are displayed as following figure. It is 

indicating settable value on camera as Min is 64, Max is 2048 and Inc is 4.  

 

 

 

 

 

 

 

Regarding the Inc value 
There is the case that feature doesn’t support Inc value. Then, Inc is not displayed 

in settable value range. 

 

7.6.4. Utilizing the Update Buttons 

The following two Update buttons are available on toolbar in Camera Control panes. The descriptions for 

them are follows. 

 

 

 

 

7.6.4.1. Update button 

When the button ① in above figure is pressed, all features existing on current pane are reloaded, and 

updated with latest value on the camera. 

For example, when the value of feature is updated from FeatureView, and even if such update will affect to 

the current value of any feature on Camera Control panes, it is not automatically reloaded into features on 

panes. Then, by pressing the button ① in above figure, it is available to manually reload the current value. 

 

① ② 

Hint 
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7.6.4.2. Auto Update button 

The button ② in above figure is only available in Image Correction and Exposure pane. This button works 

with toggle. When it is enabled, the features in current pane are automatically and repeatedly reloaded with 

fixed interval. 

If it is required to trace the specific value of some features, such as Gain, WhiteBalance or ExposureTime 

which its value is changed autonomously, this button will work effectively as the solution for users. 

The update interval for Auto Update is 1000msec. In addition, if this button is pressed again, it becomes 

unchecked state and Auto Update is disabled. 

 

7.6.5. Regarding grayed out features 

If any feature placed in current pane is grayed out, it is indicating the feature is within one of the following 

states. 

 

➢ N/A because of current camera state 

There are some features such as PixelFormat, Width, Height or else which its value cannot be changed 

while camera is in streaming. Such features can be changed when streaming is stopped. So if streaming 

is stopped with steps in “Stop”, the state of feature recovers from grayed out to normal and it will become 

able to change the value. 

 

➢ N/A because of relationship with other features 

There is a case that the feature is grayed out relating to current setting of other features. For example, 

AcquisitionFrameRate is available when AcquisitionFrameRateControl is set to “Manual”. When current 

value of AcquisitionFrameRateControl is other than that, it is grayed out and N/A. 

 

➢ N/A in current camera 

If the feature is not supported in current camera, it is grayed out and N/A. 

 

 

In case the detailed information  

for features supported in  

current camera is required 

If it is required to know the more detailed information for each feature 

supported in current camera, users can confirm it with user manual. It 

can be downloaded from our website. 

 

Hint 
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7.6.6. Recommended usage 

The panes implemented within TeliViewer can be used with tabified or multilayered into dock as following. 

By the operation of drag and drop with mouse, users can arrange the placement of them, for easy accessing to 

each feature, or according to user’s preferences. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Multilayer 

Tabify 
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7.7. Multicast 

This feature described as follows is only available for GigE camera. 

By this feature, it is available that multiple hosts can retrieve the images from one GigE camera. 

 

7.7.1. Overview 

The following figure shows overview and typical construction of network for using the Multicast. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Devices Descriptions 

① GigE camera GigE camera that will deliver the image using Multicast. 

② Distributor 

Typically, it is the device called as switch or router. It must be the device such as L3/L2 

switch or router that is supporting Internet Group Management Protocol (IGMP) or 

IGMP Querier feature, for executing Multicast transmission. 

③ Controller 

It is a host system accessing to camera with RW access rights. It means that such host 

controls the camera, retrieves the image, and is called as Controller. In a Multicast 

group, only one host can act the role of the Controller. 

④ Listener 

They are host systems accessing to camera with RO access rights and retrieving the 

image without controlling the camera. Such hosts are called as Listener. As above 

figure, multiple Listeners can exist in a Multicast group. 

 

 

 

Regarding the IP address settings  

for each device 

It is required to apply appropriate IP address and subnet mask to communicate 

between each device. Regarding IP address assignment, etc., it is recommended 

to confirm with the administrator of the current network, before setting up. 

 

① 
② ③ 

④ 

④ 
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7.7.2. Access Mode Setting 

The access mode for each host must be set up as following table. Basically, users need not to care to 

change it since when the camera is opened, it is automatically decided by TeliViewer. 

Hosts Access Mode Details 

Controller Control Open the camera with RW access rights 

Listener Monitor Open the camera with RO access rights 

 

For instance, when the GigE camera is already opened from Controller, TeliViewer determines the 2nd or 

later host that try to open same GigE camera is Listener. Then, Monitor for Access mode is automatically 

selected for such hosts. 

As the exception, in case a Listener open the camera before Controller, it is required to select Monitor for 

Access mode manually in Listener host. For changing the Access mode, refer to “Access mode selection”. 

 

7.7.3. Multicast Setting 

By selecting the [View] → [Camera Control] → [GEV Setting] on menubar, following pane is displayed. In 

this pane, Multicast can be set up. The description for setting up each item is as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① 

② 

③ 

④ 

⑤ 
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 Items Descriptions 

① MaxPacketSize 

Packet size for streaming with Multicast is specified in this field. It must be used as the 

common value for all hosts and camera, in a Multicast group. For details to decide such 

value, refer to “Determine MaxPacketSize”. 

② Access Mode 
Current Access Mode is displayed in this field. In Controller, “Control” is displayed, and in 

Listener, “Monitor” is displayed. 

③ Enable multicast By turning “ON” this, Multicast is enabled. 

④ Address 

IP address for Multicast is set in this field. Default value is “224.64.16.1”. It must be used 

as the common value for all hosts and camera, in a Multicast group. If it is needed to 

change, IPv4 multicast addresses defined by standards must be used. For details of 

standards, refer to RFC documents or else. 

⑤ Port 

Port number for Multicast is set in this field. Default value is “50506”. It must be used as 

the common value for all hosts and camera, in a Multicast group. If it is needed to change, 

note that port numbers reserved as System Ports (or Well-Known Ports) are not 

available. For details of available port numbers, refer to the IANA website or other 

sources. 

 

7.7.4. Details for Setup 

This section describes the specific setup procedures for Multicast. 

 

7.7.4.1. Determine MaxPacketSize 

First, the available MaxPacketSize for all hosts must be determined. Such value depends on the 

construction of a Multicast group. To determine it, the JumboPacket or Maximum Transmission Unit (MTU) 

size of all hosts in a Multicast group must be researched as follows. 

 

 

How to check/set JumboPacket  

or MTU size 

In Windows, the JumboPacket can be set by opening the properties of 

the network adapter from the Device Manager. In Linux based OS, the 

MTU can be set using ifconfig, etc. For details, refer to the OS manual or 

ask administrator of current network. 

 

As a result of research, if a Multicast group is constructed with following table: 

Host JumboPacket / MTU size 

Controller 9014 

Listener (A) 8192 

Listener (B) 4096 

For MaxPacketSize, select the “maximum size that all hosts can receive”. 

So, in above example, appropriate MaxPacketSize is 4096. This value should be used in following steps for 

setup. 

Appropriate MaxPacketSize 

4096 

Hint 
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7.7.4.2. Setup for Controller 

It is recommended that the Controller is configured first, and next the Listener. 

The steps for setting up the Controller is as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.7.4.3. Setup for Listener 

It is recommended that the Controller is configured before the Listener. 

The steps for setting up the Listener is as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

[Steps] 

1) Launch TeliViewer in Controller 

2) Open GigE camera with steps in “Camera Open/Close” 

3) Open “GEV Setting”. Then, confirm Access Mode is “Control” 

4) Check the check box of Enable multicast 

5) If it is needed to change the Address and Port, set them appropriately. If it is not needed to make any 

changes, users can use with default settings. 

6) Set “Determined value” to MaxPacketSize 

7) Start streaming with steps in “Control for stream” 

8) Confirm the image from camera is displayed correctly 

[Steps] 

1) Launch TeliViewer in Listener 

2) Open GigE camera with steps in “Camera Open/Close” 

3) Open “GEV Setting”. Then, confirm Access Mode is “Monitor” 

4) Check the check box of Enable multicast 

5) Set the same values as the Controller for Address and Port 

6) Set the same values as the Controller for MaxPacketSize 

7) Start streaming with steps in “Control for stream” 

8) Confirm the image from camera is displayed correctly 
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7.8. Waveform 

This chart displays the luminance characteristics in current image. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The details for each item in this monitor are following. 

 Items Details 

① Monitor Luminance characteristics in current image is displayed. 

② Color assortment Specify the color assortment for monitoring. It can be specified the range from 0 to 255. 

③ Monitoring range 
Specify the monitoring range. The range that can be specified depends on setting of ⑤ in 

this table and width or height in current image. 

④ Pause button When this button is pressed, update of monitor is paused. 

⑤ Direction setting Specify the horizontal or vertical for monitoring direction. 

⑥ Data type 
Specify the YUV or RGB for monitoring. By checking each check box, each component in 

current image can be selected for monitoring. 

⑦ Sampling Area 
By pressing the Area button, it becomes into area-specified mode. Under this mode, it is 

enabled to specify the limit of area for sampling. 

⑧ Sub line Three lines can be drawn on monitor by this. 

⑨ Intensity Intensity setting of each component can be changed on the monitor. 

 

 

 

Changing the update interval of  

monitor 

If it is needed to change the update interval of monitor, it can be changed 

with “Updating interval of charts” in options dialog. 

 

② 

② 

③ ③ 
④ 

⑤ ⑥ 

⑦ 

⑧ 

⑨ 

① 

Hint 
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7.9. Vectorscope 

This chart displays the characteristics of chrominance components of U and V in current image. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The details for each item in this monitor are following. 

 Items Details 

① Scope Displays the current characteristics in current image. 

② Current value Displays the value of the mouse cursor position on the scope. 

③ Pause button By pressing this button, the update of the scope can be paused. 

④ Intensity Intensity setting of each component can be changed on the display. 

⑤ Magnification Magnification can be changed on the display. 

 

 

 

Changing the update interval of  

monitor 

If it is needed to change the update interval of monitor, it can be changed 

with “Updating interval of charts” in options dialog. 

 

① 

② 

③ 

④ 

⑤ 

Hint 
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7.10. Histogram 

This chart displays the distribution of pixel value in current image. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The details for each item in this monitor are following. 

 Items Details 

① Histogram 
Current distribution of pixel values is shown as a chart. When the mouse cursor is moved 

over ①, the frequency of each data component selected in ⑥ is displayed as a tool tip. 

② Frequency (Y axis) 

For each data component selected in ⑥, the frequency of appearance of each pixel value 

is shown. Maximum value of the Y axis changes dynamically according to the current 

image. 

③ Pixel value (X axis) 

It indicates the pixel value. The Maximum or Minimum pixel value depend on the current 

image format. The above figure shows an example, when RGB format is selected, 

displaying values from 0 to 255. When the mouse cursor is on the X-axis, the partial 

magnification is available by holding down the Ctrl key and moving the mouse wheel 

up/down. 

④ Reset axes 
It is available when the X axis is in the magnified state at ③. Pressing this button resets 

the magnification and returns to the normal scale state. 

⑤ Statistics 

It is available only when a single component is selected in ⑥. It displays the Mean, 

Standard Deviation, Minimum and Maximum values for the currently selected data 

component. 

⑥ Component selection 

It allows users to select the data component to be shown as a histogram. If the current 

image is mono format, only Y can be selected. If the image is in color format, all data 

components are available for selection. The above figure shows an example of selecting 

R, G, and B on a color image. 

 

 

 

Changing the update interval of  

monitor 

If it is needed to change the update interval of monitor, it can be changed 

with “Updating interval of charts” in options dialog. 

 

① 

② 

③ 

⑤ ④ 

⑥ 

Hint 
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7.11. Save/Load camera features 

By using the following buttons on the toolbar, it is available to save or load the camera features. 

 

 

They are shortcuts to the feature implemented in FeatureView. For details on how to operate them, refer to 

the descriptions in “Save/Load camera features” section of FeatureView. 

 

 

7.12. Video recording 

This feature enables users to record the streaming images as the video into AVI or MP4 file format. 

 

 

Regarding the available platforms 
This feature is not available on platforms that use the ARM architecture, such as 

the Raspberry Pi. 

 

7.12.1. Precautions for using this feature 

Please use this feature if you fully understand and agree with the following precautions. 

 

1) Regarding the video recording feature 

TeliViewer uses GStreamer for the video recording feature. Users can use such feature by installing 

GStreamer into user’s environment. 

 

2) Regarding the recording videos to file 

Users can choose either uncompressed (default) or compressed when recording the videos to file on 

TeliViewer. If users require the video to be compressed, it is possible by using the encoder. 

 

3) Installation of encoders 

By installing the GStreamer Plugin, users can use the encoder to record the videos on TeliViewer. 

 

4) Regarding the selection of encoder 

Each encoder has an individual license, and there is the case it contains patented technology. Users 

should select the encoder under user’s responsibility and then must agree to follow the terms and 

conditions of the selected encoder. 

 

5) In case of selecting any H.264 encoder 

If users use a technology equivalent to the H.264 standard for video compression, users must agree to the 

following terms and conditions: 

https://www.mpegla.com/wp-content/uploads/avcweb.pdf 

[Note] 

For further details, such as the “Where End User pays for AVC Video” clause, users should refer to the 

applicable terms and conditions in above documentation. 

 

6) Regarding the workings of encoder 

This document describes reference procedures for using the encoder on TeliViewer. However, please note 

that it does not guarantee that the encoder will work correctly on demand of users. 

Attention 

https://www.toshiba-teli.co.jp/en/
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7) Regarding the following usage procedures 

The following contents are reference procedures when this document was prepared, and information 

regarding the URLs and installation procedures are subject to change depending on the circumstances of 

the module distributor. Even if there are any points in the following procedures that do not correspond to the 

current situation, users have to solve them by themselves by using internet searches, etc. 

 

8) Disclaimer 

➢ Our company is not responsible for any problems that users meet as a result of using the encoder. 

Please contact the encoder distributor for any problems when using the encoder. 

➢ Our company is not concerned with any licensing or patent issues arising from the choice by users 

made in 4) above. 

➢ Our company is unable to answer to any questions from users about the encoder. 

 

7.12.2. Installation of GStreamer 

To use this feature, users need to install GStreamer into user’s environment according to the following 

procedure. 

 

7.12.2.1. Windows 

To use the GStreamer package on the Windows environment, users need to follow the instructions below to 

download, install and properly configure the path to the GStreamer package. 

If users are unclear about anything in the explanations in this manual, please also check the links below for 

further information. 

[GStreamer: Installing on Windows] 

https://gstreamer.freedesktop.org/documentation/installing/on-windows.html?gi-language=c 

 

7.12.2.1.1. Download of GStreamer package 

Download the “runtime installer” that matches user’s environment from the link below. 

https://gstreamer.freedesktop.org/download/ 

 

7.12.2.1.2. Installation of GStreamer package 

Launch the downloaded installer and install GStreamer. Depending on the installation option that the user 

selected, the configuration of the installed Plugin will differ. For more information, please refer to the 

GStreamer user manual. 

 

7.12.2.1.3. Configuration of path 

After installing GStreamer, users need to configure the path settings to make it available from TeliViewer. 

Please refer to the following instructions to set up the path. 

The following procedure describes the case of installation to the default installation folder “C:¥gstreamer” as 

an example. Please note that if user install to a location other than the default, user need to set a different 

folder path to the one described in the following procedure. 

https://www.toshiba-teli.co.jp/en/
https://gstreamer.freedesktop.org/documentation/installing/on-windows.html?gi-language=c
https://gstreamer.freedesktop.org/download/
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[Steps] 

1) Right-click the Windows Start button 

2) Select [System] from the menu that appears 

3) Scroll downwards in the opened window and select [Advanced system settings] 

4) Select the [Advanced] tab and press the [Environment Variables] button 

5) The dialog box shown below is displayed, select the [Path] row and press the [Edit] button 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6) The dialog box shown below is displayed and press the [New] button 
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7) When the path input mode will be entered, set “C:¥gstreamer¥1.0¥msvc_x86_64¥bin” as shown below, 

then press the OK button and save. If the installation destination is changed to another folder different from 

the default in the installation procedure, set “%Destination folder%¥1.0¥msvc_x86_64¥bin” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8) Press the OK button to close [Edit environment variable] dialog box 

9) Restart Windows to reflect the changes to the entire system 

 

7.12.2.2. Linux based OS 

Please refer to the links below for further information. 

[GStreamer: Installing on Linux] 

https://gstreamer.freedesktop.org/documentation/installing/on-linux.html?gi-language=c 

 

7.12.3. Video recording settings 

1) Open the camera to which user want to record the video 

2) Select [Recording] → [Settings] from the menubar as shown below 

 

 

 

 

https://www.toshiba-teli.co.jp/en/
https://gstreamer.freedesktop.org/documentation/installing/on-linux.html?gi-language=c
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3) As the result, the dialogue box shown below will open. Users can configure the settings for the video file to 

be saved 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.12.3.1. File path 

By setting the ① in above figure, users can select the destination folder for the video file. Default folder is as 

follows: 

OS Folder 

Windows %HOMEPATH%Videos 

Linux based OS $HOME/Videos 

 

 

Selection of the storage medium 

on which to save the video 

The video recording feature is affected by the write speed supported by 

the storage medium selected as the storage destination. If the write 

speed to the storage medium is slow, this can cause problems such as 

dropped frames when writing. If the user wishes to save videos with 

higher quality and reproducibility, it is recommended to select a storage 

medium that supports high-speed writing, such as M.2 or SSD, as the 

video storage destination. 

 

7.12.3.2. File name 

By setting the ② in above figure, Users can specify the name of the file in which the video is to be saved. 

Initially, the filename is shown in "Video_yymmdd_hhmmss" style.  

(yymmdd: Date when video record start was pressed; hhmmss: Time when video record start was pressed) 

If the user wants to specify a file name other than this, uncheck the ② and enter the name of the file to be 

saved in the edit box. 

 

7.12.3.3. File format 

Users can select the format of the file to be saved from any of the following. Select the most suitable format 

according to the playback method to be used. 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 

Hint 
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In addition, if users choose to save videos in uncompressed format, MP4 will be automatically selected. 

Format Description 

AVI Save videos in AVI format. 

MP4 Save videos in MP4 format. 

 

7.12.3.4. Use encoder 

By checking ④ in above figure, the list of encoders available in the current environment will be displayed. 

Users can use several encoders on TeliViewer, that are installed with GStreamer installation. By selecting an 

encoder from the drop-down list, users can save the video in a compressed format. 

If ④ is not checked, the video is saved in uncompressed format. Default is uncompressed. 

 

 

Regarding the encoders that  

appear in the drop-down list 

The encoders that can be selected here depend on the operating system 

and distribution currently being used, or on the installation options 

specified when GStreamer was installed. If it is necessary to find out 

information on each of the available encoders, please use an internet 

search or something similar to confirm the information. 

Additionally, in some environments, the hardware encoder is available. In 

this case, selecting a hardware encoder is likely to result in low-load 

video recording. 

 

7.12.3.4.1. Threads setting 

As a result of checking ④ and selecting an encoder, if the number of threads used for compression can be 

changed by the currently selected encoder, this menu is enabled. Increasing the number of threads used will 

reduce the time taken for compression but will increase CPU utilization. Decreasing the number of threads 

used increases the time taken for compression but decreases CPU utilization. 

 

7.12.3.5. Limit Max video frame rate 

By checking ⑤ in above figure, it is possible to limit the maximum frame rate saved in a video file. This can 

work as effective workaround when users want to avoid video files becoming bloated. 

The range of available values depends on the current "AcquisitionFrameRate" setting of the camera. 

 

7.12.3.6. Limit Max frame to save 

By checking ⑥ in above figure, it is possible to limit the maximum number of frames that can be saved to a 

video file. Users can use this function if it is necessary to end video recording when a specific number of 

frames have been saved, without unlimitedly continuing to save the video. 

 

7.12.3.7. Optimization for uncompressed video 

If ④ is unchecked, the video is recorded in uncompressed format. Then, the menu item ⑦ is activated and 

users can select a setting from one of the following options. 

Hint 
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Setting Description 

Scale down FPS 
Optimizes the frame rate (automatic frame decimation) when 

writing images to video files and saving them. 

Scale down image size 
Optimizes the image size (automatic size shrinking) when writing 

images to video files and saving them. 

 

 

Regarding the video recording  

in uncompressed format 

When recording image data received from the camera as video in 

uncompressed format, the capacity is generally larger than for encoded 

video. Although it depends on the write speed of the destination media, in 

many cases it can lead to problems such as dropped frames due to 

overcapacity, users may have the likelihood of not achieving the desired 

video recording deliverables as the result. As the workaround, TeliViewer 

uses whichever option is selected here to optimize the writing speed to 

the media to around 150 MB/sec when recording the videos in 

uncompressed format. Such procedure brings the result in smooth 

playback of the recorded video. 

 

7.12.4. Recording the video 

It can be operated from the toolbar on the TeliViewer to start/stop video recording. 

 

7.12.4.1. Start recording 

1) Start streaming from camera. 

2) Press the button shown below, located on the toolbar. Then, video recording will be started. 

 

3) Please wait until the required recording time. 

 

7.12.4.2. Stop recording 

1) Press the button shown below, located on the toolbar. Then, video recording will be stopped. 

 

2) The recorded video is saved to file specified with “File name” into the location specified with “File path”. 

 

Hint 
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7.13. Tools 

By selecting [Tools] from the menubar, the following features are available. These allow users to change 

various settings for using TeliViewer. 

 

7.13.1. Launch “IP Configuration tool” 

By selecting [Tools] → [IP Configuration Tool] from the menubar, it is possible to launch an external tool "IP 

Configuration tool". This allows users to change the IP address settings for any GigE camera of products of 

Toshiba Teli on current network. 

 

7.13.2. Options 

By selecting [Tools] → [Options] from the menubar, dialog for setting the options is opened as following figure. 

This allows users to change various settings for TeliViewer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① 

② 

③ 

④ 

⑤ 

⑥ 

⑦ 

⑧ 

⑨ 

⑩ 

⑪ 
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7.13.2.1. Updating interval of charts 

By using ① in above figure, users can change the settings for the update interval of the charts implemented in 

TeliViewer, such as Waveform、Vectorscope、Histogram. Default setting is 2.00 sec. 

 

7.13.2.2. Save and restore Grid/4x4 settings 

By turning ON the “Enable” checkbox ② in above figure, the state of the lines drawn in the current image can 

be saved/restored. Refer to the following process steps to save/restore it. Default setting is OFF. 

 

 

 

 

 

 

 

 

 

 

7.13.2.2.1. Save always when camera is closed 

This feature is available when the “Enable” checkbox of ② is set to ON. If this is also set to ON, the current 

line drawing status is automatically saved or updated each time when camera is closed. If user want to use the 

data saved with the “Save now” button always and repeatedly when camera is opened, set this check box to 

OFF. 

 

7.13.2.3. Save and restore camera streaming status 

By turning ON the “Enable” checkbox ③ in above figure, the current streaming status of the camera can be 

saved/restored. Refer to the following process steps to save/restore it. Default setting is OFF. 

 

 

 

 

 

 

 

 

 

 

 

 

[Steps] 

1) Draw the “Grid” or “4x4” on current image 

2) Turn ON the ② 

3) When “Save now” button is pressed, TeliViewer saves the state of lines to “line configuration file”. At the 

same time, TeliViewer saves “ModelName/SerialNumber/DeviceUserID” as the identification ID 

4) Open the camera that was closed in above step 3). Then, if there is a “line configuration file” with an 

identification ID that matches the “ModelName/SerialNumber/DeviceUserID”, it is read out 

5) When streaming is started, the state of the lines that was drawn in above step 1) is restored 

[Steps] 

1) Start streaming with currently opened camera 

2) Turn ON the ③ 

3) When “Save now” button is pressed, TeliViewer saves the state of streaming to “streaming status 

configuration file”. At the same time, TeliViewer saves “ModelName/SerialNumber/DeviceUserID” as 

the identification ID 

4) Close TeliViewer 

5) When TeliViewer is launched in next time, if there is a camera that has “ModelName/SerialNumber/ 

DeviceUserID” matching to identification ID within “streaming status configuration file”, the camera is 

automatically opened and the stored data in file is read out, and set to the camera 

6) As the result, streaming status is restored 

https://www.toshiba-teli.co.jp/en/
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7.13.2.3.1. Save always when TeliViewer is closed 

This feature is available when the “Enable” checkbox of ③ is set to ON. If this is also set to ON, the current 

streaming status is automatically saved or updated every time when TeliViewer is closed.  

It means that if user want to restore the last working state of the TeliViewer every time when user launch it 

again, then set this checkbox to ON. 

If user want to restore the streaming status saved with “Save now” button, and launch the TeliViewer with it 

every time, this checkbox should be set to OFF. By setting this to OFF, the "streaming status configuration file" 

will not be overwritten. 

 

7.13.2.4. Launch with full screen 

This feature is available when the “Enable” checkbox of ③ is set to ON. By setting ④ to ON, the next time 

TeliViewer starts up, it will launch in full screen mode. 

 

7.13.2.5. Hide exit button and cursor on full screen 

By turning ON the checkbox ⑤ in above figure, it is possible to hide the “Exit button” that appears in the 

bottom right corner on the full screen. Also, mouse cursor on the full screen is hidden.  

In this state, to exit the full screen, press the ESC key. 

 

7.13.2.6. Background Color 

This allows users to set the background color of the image. It is available in either Black or Cobalt Blue. Default 

is Black. 

 

7.13.2.7. 2in1/4in1 setting 

By setting up ⑦ in above figure, the layout of the 2in1/4in1 screen can be changed. Details of each setting 

are as follows. 

 

7.13.2.7.1. Display TabBar 

It displays the camera identification and the current drawing information in tabbar. An example of the display 

is shown in the following figure. Note that this mode and “Overlay the information” cannot be selected at the 

same time. 
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7.13.2.7.2. Overlay the information 

It displays the camera identification and the current drawing information as the overlay on the image. An 

example of the display is shown in the following figure. Note that this mode and “Display TabBar” cannot be 

selected at the same time. 

 

 

 

 

 

 

 

 

 

 

 

 

Regarding the impact on Overlay 
This feature affects the performance of rendering. If enabled, note that the Display 

Rate may be slightly lower than when using the “Display TabBar”. 

 

7.13.2.7.3. Display Scrollbar 

When the image extends beyond the display area, this option allows users to select whether scroll bars are 

displayed. When the setting is turned “ON”, scroll bars will appear as shown in the following figure, and the scroll 

bars is available to scroll the image. 

If the setting is “OFF”, the scroll bar will not appear even if the image extends beyond the display area, so the 

display area will not be made narrower by the scroll bar. In addition, even when the scroll bar is not displayed, the 

image can be scrolled by using the “Scroll feature”. 

Users can select the most appropriate setting according to their preferences. 

 

 

 

 

 

 

 

 

 

 

 

 

Regarding the scroll bars in Fit  

mode 
Note that scroll bars are not displayed when images are displayed in Fit mode. 

 

Scroll bar 

Attention 

Attention 
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7.13.2.8. Enable stream stats collection 

By turning ON the checkbox ⑧ in above figure, it is possible to collect and display stream stats. This feature 

is available for U3V and GEV cameras. The each information for U3V/GEV can be displayed by following 

procedure. 

 

 

Regarding the collection and 

display stream stats 

Since this feature spends CPU resources, it is recommended to turn OFF when it 

is not required. 

 

7.13.2.8.1. For U3V 

By selecting [View] → [Camera control] → [U3V Info] from the menubar, users can display the “Stream stats” 

in U3V Info pane. 

 

7.13.2.8.2. For GEV 

By selecting [View] → [Camera control] → [GEV setting] from the menubar, users can display the “Stream 

stats” in GEV setting pane. 

 

7.13.2.9. Enable GenTL devices 

Since this feature is existing for the purpose of user support, basically use it with ON. 

By turning OFF the checkbox ⑨ in above figure, GenTL devices are disabled in TeliViewer. Default setting is 

ON. 

 

 

If it is set to OFF Note that users cannot use the CoaXPress camera under it is OFF. 

 

7.13.2.10. Maximum messages in Status Log 

By setting the value of ⑩ in above figure, it is possible to change the number of messages displayed in the 

“Status Log”. Default is 50. 

 

7.13.2.11. RestoreDefault 

By pressing ⑪ in above figure, it is possible to restore the TeliViewer screen configuration, such as 

placement of panes or button state, to the recommended default. 

 

Attention 

Attention 
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7.14. Help 

By selecting [Help] from the menubar, the following features are available. It will help the users according to 

their necessary. 

 

7.14.1. Open user manual 

By selecting [Help] → [Open user manual] from the menubar, users can open this document "TeliViewer 

User manual". 

 

7.14.2. About 

By selecting [Help] → [About] from the menubar, users can confirm the information related to TeliViewer, 

such as version number, etc. 
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8. Appendix 
This section describes general supplementary information for using TeliViewer. 

8.1. Enlargement of the pane to the four corners 

When right-clicking on the area of a pane that has no buttons, lists, or other controls, a context menu is 

displayed to enlarge the pane. The following four types of items are displayed. These will only be displayed when 

available. 

➢ Enlarge to left 

➢ Enlarge to right 

➢ Enlarge to top 

➢ Enlarge to bottom 

The following is an example of "Enlarge to right" operation. 

 

1)  As following figure, “Status Log” pane does not occupy the lower right corner of the window. In this case, 

right-clicking on the area of a pane without any controls will display "Enlarge to right". When it is selected, 

the “Status Log” pane is enlarged to the right. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2) As a result, the “Status Log” pane occupies the lower right corner of the windows as following figure. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Regarding the “Enlarge to left”, “Enlarge to top” or “Enlarge to bottom”, almost same effect is available. It is 

recommended that users utilize the above procedure to obtain the most suitable placement and size of pane. 

To the right, enlarge pane 
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8.2. About Save/Restore settings for TeliViewer 

TeliViewer automatically saves the current application state to a configuration file on the file system, when it 

is terminated by user operation, or when it receives the application termination signal from OS. Also, the saved 

state will be restored at the next launch. 

The target of save/restore here is the settings for the application, such as the screen configuration of 

TeliViewer, or the button state of FeatureView, StatusLog, or else. Note that settings for each camera are not 

saved automatically. Refer to the following hints for saving/restoring settings for each camera. 

 

 

To save/restore camera settings Refer to “Save/Load camera features”. 

To save/restore Grid/4x4 settings Refer to “Save and restore Grid/4x4 settings”. 

To restore the default state of  

TeliViewer 

Refer to “RestoreDefault”. If this is executed, it is possible to restore 

TeliViewer to the default state of the initial installation. 

Regarding the directory where 

the TeliViewer settings are saved 

[Windows] 

It will be saved to the TeliViewer.ini file under the “%APPDATA%¥TOSHIBA 

TELI¥TeliCamSDK” directory. 

[Linux based OS]  

It will be saved to the TeliViewer.ini file under the “$HOME/.teliviewer” directory. 

 

 

 

For Raspberry Pi OS users 

Under the Raspberry Pi OS, if the OS shutdown process is executed while 

TeliViewer is running, the application state will not be saved. It is caused by the 

reason why such OS never notifies the termination signal to application at 

shutdown. 

To save the TeliViewer state under such OS, close TeliViewer by user operation, 

and after confirming that it is closed completely, then execute OS shutdown. 

 

[Note] 

This problem does not occur under the Windows or ubuntu OS. Even if the OS is 

shut down while TeliViewer is running, the state will be saved correctly. 

Hint 

Attention 
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9. FAQ 
 

Question Answer 

Tearing occurs in image 

If the appropriate driver for graphics card is not installed into system, 

optimal performance may not be achieved. In addition, there is the case 

that problems such as tearing appear. For information on how to get the 

appropriate driver, refer to the website of the vendor of the graphics card. 

Note that tearing cannot be avoided on the Raspberry Pi due to graphics 

card performance limitations. 

System freezes while streaming on 

Raspberry Pi 

On the Raspberry Pi, there is the case that freeze phenomenon occurs 

while streaming from the camera. If this happens frequently, it is 

recommended to consider using “ubuntu MATE” instead of "Raspberry Pi 

OS". To use "ubuntu MATE", users need to utilize “Raspberry Pi Imager” 

to install the most appropriate ubuntu for the Raspberry Pi on a bootable 

SD card (note that this operation will erase all the data on the SD card). 

Next, boot ubuntu using the SD card image that was created by user, and 

then run "sudo apt install ubuntu-mate-desktop" from the terminal. After 

rebooting, the lightweight desktop "ubuntu MATE" will be available and 

may work as the workaround for the freezing phenomenon. 

[Note] 

For more information regarding the “Raspberry Pi Imager” and creating 

the OS image, refer to the Raspberry Pi OS website. 

After upgrading the TeliCamSDK  

package, the TeliViewer screen  

configuration became unexpected. 

Currently saved application settings may not match the new version. In 

that case, it is recommended to execute “RestoreDefault”. After that, it 

will be launched with the configuration most appropriate for the current 

version. 

Under the virtual environment,  

streaming of multiple cameras does 

not work correctly 

Under such environment, even if user environment meets the hardware 

and software requirements, there is a possibility sufficient performance 

will not be achieved (It is based on the results of some our evaluation). 

For inquiries regarding virtual environments, such as performance issue, 

please contact the provider of it. 

When streaming multiple cameras  

simultaneously, frame rate does not  

achieve the max performance of  

camera 

Due to bottlenecks dependent on the OS or display adapter driver, there 

is the case that the display rate does not achieve sufficient performance 

in 2in1/4in1 mode. For streaming in 2in1/4in1 mode with high 

performance display rate, it is recommended to select the Linux based 

OS (e.g., ubuntu) on the environment that meets hardware requirements. 

As a result of our evaluation, there is the tendency that, on the same 

hardware, better performance streaming is achieved under the Linux 

based OS, than other OS. 

Packet Lost error appears in  

StatusLog when streaming multiple  

cameras simultaneously 

When the amount of data transferred from the camera exceeds the 

transfer capacity of the data bus on the system, there is a possibility that 

packet loss may occur. Even if CPU capability is sufficient, packet loss 

may occur if the data bus does not have sufficient bandwidth. If it is 

intended to stream multiple cameras at the same time, make sure that 

there is enough bandwidth on the data bus. 
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On ubuntu 22.04LTS, the display  

rate is lower when using full screen  

mode 

In the default window system adopted by ubuntu 22.04LTS, GNOME 

Desktop is selected along with Wayland. When using TeliViewer in full 

screen mode in this environment, there is the case that this problem will 

occur. Also, it has been confirmed that this problem can be solved with 

the workaround by selecting the Xorg or MATE Desktop for the window 

system. In the case when any user faces this problem and has 

operational inconvenience, it is recommended to consider using either 

Xorg or MATE Desktop. The window system can be switched by 

selecting "Ubuntu on Xorg" or "MATE" from the session list at graphical 

login. In addition, it is available to select MATE Desktop by installing it 

with following the procedure.  

“sudo apt install ubuntu-mate-desktop” 

[Note] 

For detailed information regarding window systems, etc., refer to the user 

manual of ubuntu. 
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10. Miscellaneous topics 
 

10.1. Revision History 

Date Version Description 

2021/10/01 1.0.0 Initial release 

2022/07/25 1.0.1 The following features are appended: 

➢ Histogram 

➢ Move 4x4 by mouse drag 

➢ Multicast 

➢ Save/Load XML file 

➢ Add format for Save image as follows: 

BMP(8/24/32bpp)、PNG(8/16/24/32/48bpp)  

➢ Launch IP Configuration tool  

➢ Open user manual 

Also, some other modifications such as minor changes, correction of descriptions, 

etc. were applied. 

2023/02/28 1.0.2 Some minor changes are applied regarding the description. 

2023/05/12 1.0.3 The following features are appended: 

➢ StatusLog 

- Save events 

➢ Retrieving and displaying Camera event 

➢ Video recording 

➢ Options 

- Enhancement for Save and restore Grid/4x4 settings 

- Save and restore camera streaming status 

- Launch with full screen 

- Hide exit button and cursor on full screen 

- Enable stream stats collection 

- Enable GenTL devices 
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10.2. Disclaimer 

The disclaimer for the Logging Tool follows the disclaimer for the TeliCamSDK. 

The disclaimer of TeliCamSDK is described in another “License Agreement TeliCamSDK Eng.pdf”. 

Make sure to read this Agreement carefully before using it.  

Refer to the following folder. 

Windows version :  [TeliCamSDK installation folder]/Licenses 

Linux version  :  /opt/TeliCamSDK/licenses 

  

10.3. License 

TeliCamSDK consists of multiple, independent software components. Each software component is 

copyrighted by a third party. TeliCamSDK uses software components that are distributed as freeware 

under a third-party end-user license agreement or copyright notice (hereinafter referred to as a “EULA”). 

 

Some EULAs require that the source code of the applicable component be disclosed as the condition for 

distributing the software component in executable format. You can check the software components subject to 

such EULA requirements. For more information, please contact our inquiries described in section 7.4. 

 

Toshiba Teli corporation provides a warranty for TeliCamSDK under conditions set forth by Toshiba Teli 

corporation. (See the following documents. 

Windows version :  “License Agreement TeliCamSDK for Eng.txt”, 

“License Agreement TeliCamSDK for Sample Eng.txt” 

 Linux version  :  “License Agreement TeliCamSDK for Linux Eng.txt”, 

“License Agreement TeliCamSDK for Linux Sample Eng.txt” )  

However, some of the software components distributed under an EULA are made available for use by the user 

on the assumption that they are not copyrighted or warranted by a third party. These software components are 

licensed to the user free of charge and therefore not covered by any warranty within the scope of the 

applicable laws. These software components are not subject to any copyrights or other third-party rights and 

are provided in “as is” condition without any warranty, whether express or implied. “Warranty” here includes, 

but not limited to, an implied warranty for marketability 

or fitness for specific uses. All risks associated with the quality or performance of these software components 

are assumed by the user.  

 

EULAs are included in the following directory: 

Windows version : [TeliCamSDK installation folder]/Licenses 

Linux version  : /opt/TeliCamSDK/licenses 

 

Toshiba Teli corporation shall not be liable whatsoever for any cost of repair or correction or other incidental 

expense incurred in connection with a defect found in any of these software components. Unless specified 

under the applicable laws or in a written agreement, a party who changes or redistributes the software with 

consent from the copyright holders or based on the aforementioned licenses shall not be held liable 

whatsoever for any loss arising from the use of or inability to use such software components. The same 

applies even when the copyright holders or relevant third parties have been informed of the possibility of such 

loss. “Loss” here includes normal, special, incidental and indirect loss (including, but not limited to, the loss of 

data or its accuracy; loss incurred by the user or any third party; and interface incompatibility with other 

software). Please read each EULA for details on the use conditions and items that must be observed 

regarding these software components. 
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The table below lists the software components using in TeliCamSDK, which are subject to EULAs. 

The user should read the applicable EULAs carefully before using these software components.  

Windows version 

Project name Project license 

GenICam GenApi GenICam License 

 

Linux version 

Project name Project license 

libteliusb (libusb) LGPLv2.1 

GenICam GenApi GenICam License 

Qt LGPLv3 

 

GenICam GenApi uses the following third party software. 

Project name Project license 

MathParser LGPLv2.1 

Log4Cpp LGPLv2.1 

CppUnit  LGPLv2.1 

CLSerAll NI license 

xs3p DSTC license 

xxhash xxhash license 

XSLTProc MIT license 

XSDe Proprietary 

 

TeliViewer uses the following third party software. 

Windows version 

Project name Project license 

Qt LGPLv3 

Qwt Qwt License 

OpenGL MIT license 

GStreamer LGPLv2 

 

Linux version 

Project name Project license 

libjpeg-turbo 

IJG (Independent JPEG Group) License * 1 

Clause 2 of the Modified BSD License * 2 

zlib license 

libdouble-conversion1 BSD-3-clause 

Qt LGPLv3 

Qwt Qwt License 

OpenGL MIT license 

GStreamer LGPLv2 

* 1 This software is based in part on the work of the Independent JPEG Group. 

* 2 Refer to “The Modified (3-clause) BSD License” in the libjpeg-turbo/LICENSE.md file in the 

licenses folder listed in section 10.3. 

https://www.toshiba-teli.co.jp/en/


 

 

 

 

71 

Copyright © 2021 - 2023 Toshiba Teli Corporation, All rights reserved. https://www.toshiba-teli.co.jp/en/ 

 

 DAA04027A 

 

TeliCamSDK redistributes the binaries of LGPL-applied software, and for these source code only, you have 

the right to obtain, modify and redistribute it in accordance with the LGPL provisions. 

To the customer who wants the source code, we write to the media (CD - ROM etc.) and send it by post. 

Customers must pay for actual expenses such as shipping fee.  If you want, please contact our inquiries 

described in section 7.4. We distribute source code only for open source software that you have right to obtain. 

(Source code of TeliCamSDK is not included.) Please understand beforehand that we cannot answer 

questions about the content of the source code etc. 

 

Microsoft, Windows, Windows XP, Windows Vista, Windows 7, Windows 8.1, Windows 10, Windows 11  and 

Visual C++ are the trademark or the registered trademark of Microsoft Corporation.  

USB3 Vision and GigE Vision are trademark or registered trademark of AIA (Automated Imaging Association) 

of each company. 

CoaXPress is registered trademark of JIIA (Japan Industrial Imaging Association). 

GenICam is trademark of EMVA (European Machine Vision Association). 

Furthermore, company name or product name might be trademark or registered trademark of each company. 

 

10.4. Inquiry 

For frequently asked questions (FAQ)  and answers about TeliCamSDK, GigE cameras, USB3 cameras, and 

CoaXPress cameras, please visit the "Support" - "Industrial Cameras FAQ" site on our website. 

 

If you still cannot solve the problem, please contact us using the phone number or Inquiries form from "Contact 

Us" site on our website.  

 

https://www.toshiba-teli.co.jp/en/
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